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System Requirements

Prior to installing MAPublisher 6.1,  please ensure that you have sufficient system resources,  as outlined below:

WINDOWS

Minimum Requirements for MAPublisher 6.1 with Adobe Illustrator CS
• Adobe Illustrator CS
• Intel Pentium III or 4 processor,  or equivalent
• Windows 2000 with Service Pack 3,  or Windows XP
• 256 MB of RAM
• 300 MB of available hard-disk space
• CD-ROM Drive

Minimum Requirements for MAPublisher 6.1 with Adobe Illustrator 10
• Adobe Illustrator 10.x
• Intel Pentium III or 4 processor,  or equivalent
• Windows 2000 with Service Pack 3,  or Windows XP
• 256 MB of RAM
• 300 MB of available hard-disk space
• CD-ROM Drive

MACINTOSH

Minimum Requirements for MAPublisher 6.1 with Adobe Illustrator CS
• Adobe Illustrator CS
• PowerPC G4 or above
• Mac OSX 10.2.8 or higher
• 256 MB of RAM
• 300 MB of available hard-disk space
• CD-ROM drive

Minimum Requirements for MAPublisher 6.1 with Adobe Illustrator 10
• Adobe Illustrator 10.x
• PowerPC G4 or above
• Mac OSX 10.2.8 or higher
• 256 MB of RAM
• 300 MB of available hard-disk space
• CD-ROM drive

Getting Started:  System Requirements
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Installation Instructions

INSTALLATION

1.   Make sure that you have Adobe Illustrator 10.x or Adobe Illustrator CS installed on your computer.  If Adobe  
 Illustrator is running,  exit the program.

2. Windows:  Double click the MAPublisher 6.1 Setup.exe file.
 Macintosh:  Double click the Install MAPublisher 6.1 file.

3.   Proceed through the installation screens as instructed to install the update.
 Then please refer to the Activation instructions below.

ACTIVATION

1. To activate MAPublisher 6.1 you will require a new license.  Therefore you must supply Avenza Systems with the  
 Serial Number which was supplied to you when you purchased the product. 

2. After installation of the MAPublisher 6.1 Update,  launch the version of Adobe Illustrator you installed to.   
 Then proceed to  Help > MAP Security > Register  to open the Activation Wizard.
  
 If you have an Internet connection,  select the ‘I want to activate the software over the internet’  option and click 
 the ‘Next’  button.  At the second screen,  select the option for  ‘I have already purchased MAPublisher and want to
  activate it now’  and then proceed through the wizard as instructed to supply us with your serial number and  
 complete the activation.

 If you do not have an Internet connection,  select the ‘I want to activate the software by telephone’  option and  
 click the ‘Next’  button.  Then phone Avenza to supply us with the Machine ID you see on the Finish screen, as  
 well as your product serial number.  We will then send you an email with a zipped licence file attachment.  You  
 must unzip this attachment and save the *.lic file to your MAPublisher Plug-in  folder.  This will be inside the  
 Illustrator Plug-ins folder of your appropriate version(s).

Getting Started:  Installation Instructions
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New Features 

Please read this section for an overview of the new features in this release.  
Items marked with an asterisk (*) were originally introduced in the MAPublisher 6.0.3 Update.

SINGLE PLUG-IN

MAPublisher is now available as a single plug-in,  thus dramatically increasing speed and performance.

FME COMPONENT UPDATE

The MAPublisher 6.1 Update includes the very latest updates to the core FME library from Safe Software.

JOIN POINTS

New to MAPublisher in version 6.1 is a filter to join points based on attribute values.  This tool will generate a line 
string joining common points,  and is ideal for GPS data.  For a full overview of this tool see page 7 of this guide.

EDIT COLUMN:  Graphical Properties

The Edit Column filter has been modified to enable the scaling and rotation of point symbols based on a specified 
variable or by the contents of an attribute column.  This filter will also allow text objects to be rotated.  See page 9 
for guidelines on how to use this new function.

PROJECTIONS:  Search Projection 

*A new ‘Search Projection’ tool has been added to all occurrences of the MAP View Editor and Source Projection, 
allowing you to perform a keyword search of the 4500 supported coordinate systems to find the projection that you 
require.  For more info on this tool see pages 12 to 13 of this guide.

MAP LOCATION TOOL:  Projection Info

The MAP Location Tool now also displays the projection and units of the currently selected MAP Layer,  saving you 
time when you need to quickly find this information.  

MAP LOCATION TOOL:  Copy Coordinates

Also new to the MAP Location Tool in MAPublisher 6.1 is the ability to copy the coordinates of a known point by 
simply holding down the shift key and clicking on the page.  This function is ideal for quickly building point files.  
Please see page 14 for more information.

MAP VIEWS PALETTE:  Remove MAPublisher Info

MAPublisher 6.1 contains functionality to quickly remove all MAPublisher information from your file.  At the end 
of the project cycle it may be useful to remove all georeferencing and attribute information in the document to 
reduce file size,  or to protect sensitive data.  This can now be accomplished by simply dragging your MAP Layer(s) 
to the [Non-map layers] category in the MAP Views palette.

New Features:  Overview
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IMPORTING MAP DATA:  Layer Sort

Multi-feature imports are now automatically sorted by feature type.  For example ArcInfo Export,  AutoCAD and 
Microstation files may contain more than one feature type.  Such files are now imported with text layers first,  point 
layers second,  line layers third,  and area layers fourth in the layer hierarchy.

IMPORTING MAP DATA:  Auto-scale

*An ‘Auto-scale’ function has been added to the Advanced Importer,  enabling multiple files to be ‘fit to page’ on 
import.  For more information on this tool see page 11 of this guide.

EXPORT:  Sticky Menus

*The Export Settings dialogs now remember the last selections that were made,  saving time especially when 
exporting to AutoCAD or Microstation formats.

LEGACY DOCUMENT CONVERSION
 
*MAPublisher now supports the conversion of point symbols with multiple rotations to the MAPublisher 6 format.

MAP UNIT ADDITIONS

*Additions have been made to the suite of supported Map Units,  allowing for the automatic recognition of a higher 
number of projection units during the import process.

LICENSING

*An activation wizard has been introduced to the product,  enabling you to automatically receive and install your 
license file if you do not currently possess one.  The wizard also provides for the retrieval of a license file if you have 
removed it from your system.  Navigate to the Help menu and to MAP Security > Register  to access the wizard.

*Floating licensing for Windows,  Macintosh and Linux Servers are now all fully integrated into the product.  Floating 
or networked licensing is ideal for sharing the software between multiple users in a networked environment.  Please 
contact Avenza Systems for more information.

New Features:  Overview
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Join Points
Filter > MAP Lines > Join Points

New Features:  Join Points

 Input Layer - Use this dropdown 
to select the Point Layer containing 

the symbols you wish to join.

All Points / Selected Points
 - You can choose to join only those 

points that have been selected or all 
points on the selected MAP Layer.

Close paths - Check this option to 
generate  an Area layer.  If unchecked,  

a Line layer will be generated.

Sort By Available Columns - Select 
an attribute column containing 

ascending values to sort by.  Then 
click the  ‘Add’  button to add the 

column to the Sort Order.

Output Layer - Enter the name 
of the output layer.  This new 
layer will contain the new lines.

Group By - Specify the attribute 
column containing similar values 
to determine each group of points.

Sort Order - Contains a hierarchical 
list of the columns specified to sort by.  
To remove a column from the Sort 
Order,  click the  ‘Remove’  button.

Move Up / Move Down - You can 
move columns up and down the 
Sort Order hierarchy by clicking 
the appropriate button .  

FUNCTIONALITY

The new Join Points filter lets you join a set of point symbols with a line string based on sorting criteria which exist 
in the attribute structure of the point layer.  For example,  it may be desirable to join points that were originally 
generated by a GPS device,  in order to create line elements connecting these points.  When the Join Points filter is 
run a new layer is created containing a line linking each set of common points,  with the generated layer containing 
the same common attribute column that was used to group the points together.  

PREREQUISITES

Join Points can only function on  Point layers,  and can be used on both currently selected point symbols or all 
the point symbols on a specified layer.  There must be at least two attribute columns on the specified point layer in 
order to use Join Points.  To open the dialog,  go to Filter > MAP Lines > Join Points.

USING JOIN POINTS

From the Input Layer dropdown,  select the Point Layer containing the points you wish to join.  Then specify if you 
wish to join All Points,  or just the Selected Points on this layer,  by clicking the appropriate radio button.  

Specify a name for the Output Layer that this function will generate.  By default,  the program will generate a 
 Line layer.  To generate an  Area layer (by linking the line end to the start) check the Close paths option. 

In the Group By Column dropdown,  select the attribute column containing the common attributes you wish to join 
together.  For example to join points based on a unique ID,  you should select the column containing the common 
ID names.  This will result in point symbols containing the same name being joined together.   
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As each point that is joined will be represented by a node in a line string you must now specify a logical order by 
which the points will be joined.  For example,  it is logical that the point which was captured by a GPS unit first 
should be at the first node in the line string,  with the second and third points being located at the second and third 
nodes.  In order to specify these parameters,  you must choose columns by which to sort your points.  These should 
be attribute columns which contain rising alphabetical or numerical values. 

In the Sort By Available Columns list,  select the primary sorting column.  This should be the attribute column that 
contains the best fit for rising alphabetical or numerical values.  For example if points have rising values from 1 - 10,  
the point with a value equal to 1 will be at the start of the generated line,  and the point with a value equal to 10 will 
be at the end of the line.  When you have selected the column,  click the Add button to place the column into the 
Sort Order list.  If all the values contained in the first  ‘Sort By’  column are unique,  you will not be required to set a 
secondary column.  

If the first  ‘Sort By’  column contained any similar values,  you must specify a secondary column.  Again click on a 
column in the Sort By Available Columns list,  and then click the Add button to place the column in the Sort Order 
list.  Similarly third,  fourth and fifth  ‘Sort By’  columns can be specified in the same manner if previous columns 
contain similar values.  Note that the  ‘Sort By’  columns are a hierarchy with the topmost specified column being 
used for the primary sort,  then the second,  then third etc.  

To move columns up or down the hierarchy after they have been specified,  simply select the appropriate column in 
the Sort Order list and click either the Up or Down button.  

To remove any  ‘Sort By’  columns from the hierarchy,  select the column in the Sort Order list and click the Remove 
button.  

Note that a maximum of 5 columns can be used to sort points into a logical order.  If the columns specified to sort 
by do not distinguish an ordering between certain points,  the order of these points in the attribute table  (i.e.  the 
order in which they were digitized)  will be used to determine the order of the nodes in the generated line string.

RESULTS

When you have set all your options,  click the OK button to join the points on the specified layer.  An  Area  or 
  Line layer will be generated,  depending on the specified output layer type,  which will be placed in the same 

MAP View as the Input Point layer which has been joined.

New Features:  Join Points
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Edit Column Update 
Graphical Properties

New Features:  Graphical Properties

*Layer - Select the point 
or text layer containing 

the selected elements 
you want to modify.

*Expression Column - Using 
the list box, you can add 

an attribute column which 
contains scale or rotation 

values into the Expression.

Result Type - Select the 
‘Attributes’ option to use 

the Edit Column filter as in 
previous versions.  Select 
the ‘Properties’  option to 

use the filter to change 
Graphical Properties. *Edit Expression - This is where the expression you have built for the selected 

elements are displayed.  Do not type into this field;  use only the Calculator 
Buttons and Expression Column list box to build the expression.

OK - Click the OK button 
to rotate or scale the 
selected objects based on 
the entered expression.

Calculator Buttons - You 
must use the calculator 
buttons to build your 
mathematical expression.

Clear Expression - Allows 
you to clear the entire 
expression and start over if 
you have made a mistake.

The dialog components marked with an asterisk (*) describe the new alternate functionality available when 
the  ‘Result Type’  option is set to ‘Properties’.  The original functionality of this tool is achieved by selecting  
the  ‘Attributes’  option,  therefore please see the full MAPublisher 6 User Guide for this description.

*Result Property - Choose ‘Scale’  
or  ‘Rotation’  for point elements.  
Note only  ‘Rotation’  can be 
specified for text items.

FUNCTIONALITY

The Edit Column filter now has two functionalities.  It can be used for both the editing of attribute columns for all 
feature types,  and for the editing of graphical properties for point and text items.

Edit Column now also provides for the assignment of a rotation or scale to elements,  based on the values found 
in an associated attribute column.  For example geological point files may contain such columns as  ‘Strike’,   ‘Dip 
Direction’,  ‘Inclination’  etc.  The values contained in these columns can now be used to rotate or scale the elements 
on such layers,  providing a one-step process to possibly transform different objects by many hundreds of unique 
rotation or scale values.  Text objects can be rotated using this filter,  and Point Symbols can be rotated or scaled.  To 
use Edit Column for this means,  check the Properties option.

As previously,  the filter provides for the editing of attributes for multiple features in a single step and for the 
creation of attribute values for a column based upon values in other columns.  To use this function in its traditional 
form,  check the Attributes option,  and refer to the  ‘Edit Column’  section in the full MAPublisher 6 User Guide.

PREREQUISITES FOR ‘GRAPHICAL PROPERTIES’

The Edit Column filter assigns rotations or scales to objects based upon calculations using existing columns.  This 
function can only be applied to   Point or   Text layers,  and there must be at least one column which contains 
suitable values in the layer on which you wish to perform the transformations.  Only selected objects in the 
Illustrator document will have these calculations applied.

Note that scaling can not be applied to points that already exist in a MAP Stylesheet.  You must first remove the 
Point Layer from the Point Stylesheet.
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USING EDIT COLUMN FOR GRAPHICAL TRANSFORMATIONS

To use Edit Column filter for rotating or scaling objects,  check the Properties radio button.  

This filter still works like a scientific calculator.  You must first specify the Layer on which you need to apply your new 
properties.  The  ‘Properties’  option will only be enabled when a   Point or   Text layer is selected.

A  Result Property  must be set,  which is  ‘Rotation’ or  ‘Scale’  for Points,  or  ‘Rotation’  only for text items.  The 
Expression Column dropdown should be used to choose the column which contains your rotation or scale values.  
If you need to apply further numeric values to your expression,  the Calculator Buttons can be used to add to the 
expression.  Only the listboxes and calculator buttons in the Edit Column dialog should be used to build expressions,  
and not your keyboard.  The Expression dropdown can be accessed more than once if you wish to use multiple 
columns to generate an expression.  The expression you build will be displayed in the Edit Expression field.  You can 
clear this at any stage by clicking the Clear Expression button.

RESULTS

When you have finalized your expression click the OK button.  The new rotation or scale values will be applied to the 
selected objects.  Note that scaling will not be applied to points that already exist in a MAP Stylesheet.  

The transformations that are applied are absolute values.  The filter will only apply scales or rotations to objects 
based on their original orientation,  and will not add to established scales or rotations.
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Advanced Import Update 
Auto Scale*

Auto Scale *NEW* - If you have multiple files in the File List,  
and have selected the ‘New Based On’ option,  check this box to 
ensure all the files fit inside the page extents when imported.

This new function is to enable multiple files to be  ‘fit to page’  via the addition of an Auto-scale tool.  In certain 
circumstances the previous tool set available in Advanced Import required that this procedure be completed via the 
MAP View Editor.  This tool enables you to guarantee that all selected files can be placed inside the page extents.

As previously, you have three choices when deciding a Destination MAP View:

1. You can choose to import all of the listed files in the projection and parameters that exists in one of the listed  
 files.  Click New Based On and then select one of the files in the projection you require.  If you have multiple  
 files in the File List,  you can check the Auto Scale option to ensure that when the data is imported,  it is scaled to
  fit the current page extents.  If you do not check this option,  some of your data may fall outside of the page  
 extents during the import process.

2. You can choose to import all of the listed files in the projection and parameters that currently exists in the  
 document (for example via a previous import).  In this case select Use Existing and then select the MAP View  
 containing the desired projection.

3. Finally you can choose to assign another projection completely by first selecting the Create New option,   and  
 then clicking Editor.  This will open the MAP View Editor,  allowing you to specify a projection from a projection  
 list and make numerous page scaling edits.  

Note that the  ‘Auto-scale’  function can only be activated by first choosing the ‘New based on’ option,  and is only 
required for the import of multiple files.

Please refer to the MAPublisher 6 User Guide for a full overview of the Advanced Import feature.

* This function was originally introduced in the MAPublisher 6.0.3 Update.
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MAP View Editor / Source Projection Update
Search Projection*

Search Projection *NEW* - 
Click this button to open the 
Search Projection dialog 
(below),  enabling you to search 
for projections,  datums and 
ellipsoids by specifying a 
text string.  The results of the 
search are displayed in the 
‘Search Results’ category.

Projection Category - To edit 
a projection choose an area of 
the world from this dropdown 

appropriate the current MAP View.  

*NEW* - For a list of projections 
generated by the MAPublisher 

importers that are  extra to the 
FME database,  choose ‘Custom’.

*NEW* - For the most recent 
results of a ‘Search Projection’,  

choose the ‘Search ___’  category

This update can be found in all occurrences of the MAP View Editor function.

This update can be found in all occurrences of the Source Projection function.

Search Projection

Where - Select the properties on which to 
perform the search (‘All’,  ‘Datums’,  ‘Ellipsoids’,  
‘Projection names/types’,  or ‘Units’).

 Access this dialog by clicking the    icon in the 
MAP View Editor  or in  Source Projection.

*NEW*

OK - Click this button to begin the 
search.  Results will be displayed 
in the ‘Search Results’ category.

Find what  - Type in the 
text on which to search.

New Features:  Search Projection
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The new functions in the MAP View Editor and Source Projection can be found in all occurrences of these two tools.

The MAP View Editor can be accessed at the following locations:
Advanced Import > Create New > Editor
MAP Views palette > New/Edit MAP View
Please refer to the MAPublisher 6 User Guide for a full overview of the MAP View Editor.

Source Projection can be accessed at the following locations:
Simple Import > Edit
Advanced Import > Add/Edit
MAP Views palette > Source Projection
MAP View Editor > Source Projection
Please refer to the MAPublisher 6 User Guide for a full overview of the Source Projection feature.

SEARCHING FOR A PROJECTION

The MAPublisher 6.1 update includes the addition of a Search Projection tool.  This tool will allow you to search 
for projections based on an entered variable,  and searches can be performed on the whole database,  or solely in 
Datums,  Ellipsoids,  Projection Names,  Projection Types,  or Units.

To access the Search Projection dialog,  click the    icon in the MAP View Editor or in Source Projection.

In the ‘Find what’ field enter a variable on which to search.  For example to find coordinate systems with ‘NAD83’ 
properties,  enter ‘NAD83’  in the ‘Find what’ field. 

From the ‘Where’ dropdown,  select an area of the database in which to search.  For example to find ‘NAD83’ in the 
projection name only,  select ‘Projection names’;  or to find all datums which have NAD83 properties (which may not 
include this text in their names),  select ‘Datums’.

When you have entered the search criteria click the ‘OK’ button.  If the search has returned results,  these results 
will be displayed in the MAP View Editor or Source Projection in the ‘Search Results’ category,  and can be immediately 
selected in order to reproject your data or to assign a projection.  Search results will be stored in this category until 
you restart Illustrator or perform another ‘Search Projection’.

ADDITIONAL PROJECTION CATEGORIES

This update includes the addition of two new coordinate system categories.  If a search has been performed via the 
‘Search Projection’  tool,  a ‘Search Results’  category will display the results (see above).

A ‘Custom’ category has also been added.  This category will store projections derived by the MAPublisher importers 
that are additional to the coordinate system database,  rather than solely in the ‘Recently Used’ category.  As an 
example the ‘worldeast.shp’  and ‘worldwest.shp’  files included in the Tutorial Data folder are in the projection 
‘Robinson in METER’.   This projection is not part of the current database,  and will now automatically added to the 
‘Custom’ category on import.

New Features:  Search Projection

* These functions were originally introduced in the MAPublisher 6.0.3 Update.
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MAP Location Tool Update 
Copy Coordinates

New Features:  Copy Coordinates

FUNCTIONALITY

The MAP Location Tool displays the coordinates of the mouse cursor in the Map Units of the currently selected 
Illustrator layer.  The new Copy Coordinates function enables the X and Y position of  the cursor in Map Units to be 
copied to the clipboard.  An example of a use of this function is that it enables you to build point files in an external 
text editor;  files which can then be re-imported with MAPublisher.  Coordinates are copied with the X value first and 
Y value second,  and are delimited by a comma.  For example:

   -79.396527,43.631979

An example of how to build a point file in an external text editor is as follows:  

One column in the file must contain the X coordinates of the points and another must contain the Y coordinates.  By 
copying coordinates using the MAP Location Tool,  you can add as many additional columns as you wish containing 
additional information to be imported as attribute data.  For example:

   -79.396527,43.631979,City Airport
   -79.390889,43.642204,Stadium
   -79.385921,43.660931,Shopping Mall

COPYING COORDINATES

To copy the coordinates of a specific location,  click on the MAP Location Tool    icon in Illustrator’s Main Toolbar.  
Ensure you have the appropriate layer selected in the Illustrator Layers palette,  and then with the location cursor 
determine the exact position you wish to copy.  Then hold down the Shift key and click on the document.  The X and 
Y position in Map Units will be copied to the clipboard.  You can now paste the values into any text editor.  

Note that you can only copy one set of coordinates.  When you shift-click again,  the values copied previously will be 
overwritten.

WX/WY - Displays the current X & Y 
coordinates of the cursor in Map Units.

These are the values that will be copied 
by Shift-clicking on the document. Copy Notification - When the 

location cursor is active you will 
see this text,  enabling you to copy 
the current X & Y coordinates of 
the mouse cursor.
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